Practical Podcasting:
A Technical Guide to Producing Studio-Quality Podcasts
Jacob Sarmiento (he/him)
# Table of Contents

Table of Contents.................................................................................................................. 2
Foreward.................................................................................................................................. 3
Preparing to Record.................................................................................................................. 4
  Windows................................................................................................................................. 4
  Mac........................................................................................................................................ 6
Recording.................................................................................................................................. 7
  Setting up Mics....................................................................................................................... 7
  Setting Levels and Gain-Staging.......................................................................................... 7
  Recording Into Audition....................................................................................................... 8
  Recording a Backup............................................................................................................... 10
  Final Recording Comments................................................................................................. 11
Mixing...................................................................................................................................... 12
  Exporting Files From MicroSD............................................................................................. 12
  Exporting Files from Audition.............................................................................................. 14
  Audio Restoration.................................................................................................................. 15
  EQ......................................................................................................................................... 17
  Normalization......................................................................................................................... 19
  Quote Retrieval..................................................................................................................... 19
  Assembling the Cut............................................................................................................... 20
  Compression.......................................................................................................................... 20
  Gain Staging and Automation............................................................................................... 21
  Panning.................................................................................................................................. 22
  Reverb................................................................................................................................... 23
  Final Mixing Notes............................................................................................................... 23
Mastering................................................................................................................................. 24
References.............................................................................................................................. 25
Foreward

Hello! I made this guide with the goal in mind to help in the production of podcasts at KCPR after I had graduated. The idea came to me as a result of an offhand comment by one of the hosts of the podcast I was producing about what they would do when I graduated; how would they replace me. I thought why not compile my knowledge of audio engineering into one document so that future podcast producers at the station could create high-quality podcasts? This guide is my attempt to do that. As I have been working on my last podcast for KCPR, I have been documenting every step of the way and this guide is a synthesis of these notes. It’s also my senior project :)

While this guide is intended for use by KCPR, many of the techniques and topics discussed within apply to a more general application of audio engineering. Broader topics like gain-staging, audio restoration, EQ, compression, panning, automation, and mastering will apply to producing and editing any sort of audio you can imagine. There are nuances between different applications of these topics, the compression on a podcast host’s voice is going to look a lot different than the compression on a kick drum. That being said, this guide is specifically designed for use by KCPR, so things like the mics and interface are the specific hardware that you will be using while at KCPR.

The software and DAW I use to produce are all 3rd-party applications that I have purchased or have been gifted to me. The main plug-ins I use while editing are all included in the Izotope Elements Suite which is an absolute steal for the price. I highly recommend it to any aspiring audio engineer. I also make use of Descript which is an amazing transcription application that I use to help pull quotes from interviews. I purchased a membership for myself, but as of writing there are plans for a KCPR Descript account that you could make use of. Despite this, I hope to provide tools and techniques for you to use with any software.

Thank you so much for reading!

-Jacob
Preparing to Record

Before you record, there are a few things you should do to set up your laptop for a successful recording session. This section will vary depending on your operating system. The RODECaster is most compatible with recording into Adobe Audition, so that is what this guide will cover.

Windows

1. Download the latest ASIO4ALL driver from https://asio4all.org/about/download-asio4all/
2. Download the “Podcast Interview Template” from the KCPR Podcast OneDrive and save it to the following location.
   a. Documents > Adobe > Audition > 22.0 > Session Templates.
3. Open Audition and go to the following.
   a. Edit > Preferences > Audio Hardware.
4. Change the device class to ASIO and the device to ASIO4ALL v2.
   a. Sample Rate is 48000 Hz with an I/O Buffer Size of 1024 samples.

5. Click ‘settings’ next to the device.

6. Click the power button next to the RODECaster Pro Multichannel, this should light up blue when it is turned on.
   a. Make sure any other devices are turned off, close the ASIO4ALL settings window and click OK.

7. Have a USB-C (female) adapter if your laptop does not have a USB-C port.
Mac

1. Download the “Podcast Interview Template” from the KCPR Podcast OneDrive and save it to the following location.
   a. Users > Shared > Adobe > Audition > 22.0 > Session Templates.

2. Open Audition and go to the following.
   a. Adobe Audition CC > Preferences > Audio Hardware.

3. Select RODECaster Pro Multichannel as Default Input and RODECaster Pro Stereo as Default Output and Master Clock Out.
   a. Sample Rate is 48000 Hz with an I/O Buffer Size of 1024 samples.

4. Have a USB-C (female) adapter if your laptop does not have a USB-C port.
**Recording**

Getting a good recording is the most important step to achieving a studio-quality sound. With good recordings, you will have to do minimal audio restoration which will minimize your time spent editing.

**Setting up Mics**

1. Plug XLR cables into the mic and the RODECaster. The male end of the XLR goes into the interface and the female end goes into the mic.
   
   a. The RODECaster is the primary interface used by the KCPR podcast team due to its four inputs, more than any of the studios at the station.

2. My personal preference is to number the mics from left to right and plug them into the corresponding channel on the interface.

3. Proximity effect is a phenomenon in recording that has to do with how far away the microphone is from a source. Proximity effect exaggerates the lower portion of the frequency spectrum captured by the microphone. The closer to a source, the more this effect is exaggerated which can create a fuller sound. The further away a mic is from a source, the audio will sound more hollow and more room characteristics will be captured.
   
   a. To make the best use of the proximity effect, have all folks be about a fist's distance away from their mic.

4. To help mitigate plosives, mouth noise, and because it is a station rule, put a pop filter on all the mics you will be using.

**Setting Levels and Gain-Staging**

1. Set all faders to the middle.

2. Press the button above the fader corresponding to the channel whose levels you want to set.

3. On the channel menu, tap ‘level’.
4. Talk into the mic and watch the meter on screen.

5. Tap the plus or minus to adjust the levels until they are consistently reading about -10 dB.
   a. -10 dB is chosen because it leaves headroom for loud moments, like laughter, to not cause clipping.
   b. -10 dB is also chosen to minimize or eliminate mic noise, which is an electronic buzz that is really hard to remove in post.

6. Repeat for each of the channels you are using.

**Recording Into Audition**

1. On the RODECaster enable Multitrack Recording by USB, microSD, and Post Fader.
   a. Settings > Advanced > Audio > Multitrack and tapping on USB, microSD, and Post Fader.
   b. Recording with Post Fader on ensures that any corrections you make with levels using the channel faders after setting your gain will show up in the recording.
2. Create a new multitrack session.
   a. **Win:** File > New > Multitrack Session (Ctrl+N)
   b. **Mac:** File > New > Multitrack Session (Cmd+N)

3. Name your session, select your save location, and select “Podcast Interview Template” as your template. Click OK.
   a. Sample Rate is 48000 Hz with a 24 bit Bit Depth and Stereo Mix.

4. Select your inputs.
   a. The “Stereo Mix” input is Stereo > [01S] Pro Multichannel 1.
b. The “Mic 1” input is Mono > [03M] Pro Multichannel 3.
c. The “Mic 2” input is Mono > [04M] Pro Multichannel 4.
d. The “Mic 3” input is Mono > [05M] Pro Multichannel 5.
e. The “Mic 4” input is Mono > [06M] Pro Multichannel 6.
f. The “USB” input is Stereo > [07S] Pro Multichannel 7.
g. The “TRRS” input is Stereo > [09S] Pro Multichannel 9.
i. The “Sound Pads” input is Stereo > [13S] Pro Multichannel 13.

5. Click the ‘R’ on each track to arm the track for recording, it will turn red.

6. Click Record (circular red bottom in the bottom middle of Audition).

**Recording a Backup**

1. Simply press the big record button on the RODECaster to record a backup to the microSD.
Final Recording Comments

You did it! You should have a great basis for good recordings if you follow these steps. Be hyper-vigilant during the interview and use your ears and eyes to keep track of the levels. They are your greatest tools. Something I like to do during interviews is lowering the faders of the folks not talking to help minimize mic bleed. This can be reduced or eliminated by having people further away from each other, but there may not be enough space. Mics are directional so try your best to ensure that your guests keep their mics about a fist away from their mouths and project their voice into the mic.
Mixing

Probably the most time-consuming portion of the episode. This is the meat of what you will be doing. Mixing is the process of blending tracks in a way such that the best of each track comes together into the master mix. I am using mixing in a broad sense to include everything from exporting files from the RODECaster microSD, to audio restoration, and using effects. Mixing is subjective and is ultimately up to the ear of the engineer. There are a lot of different ways to achieve a good mix. The best advice I can give for achieving a good mix is to listen to a lot of podcasts. Find things you like that you want to try to emulate and things you don’t like that you want to try to avoid. This is known as finding reference tracks in the broader world of audio engineering. Some personal favorites of mine, if you have no clue where to start, are *Renegades: Born in the USA* and *Sound Barrier* which are both accessible on Spotify. This section is about using your judgment to modify audio to what you think sounds good. Don’t worry if that sounds like a lot of pressure, you have a team working with you and giving you feedback!

Exporting Files From MicroSD

1. If your laptop does not have a microSD port, you will need an adapter to connect the microSD to your laptop.
2. Open up the microSD and save the latest files to your laptop.
3. Open Audition and you can drag the files you just saved into the main window.
4. Now open a new multitrack (Ctrl+N).
   a. Don’t worry, the “POD000XX.WAV” audio is still accessible from the top left ‘Files’ window in Audition.
5. In the top left ‘Files’ window, click the “>” to drop down all the individual track files.
6. Add the POD tracks to the multitrack session. Repeat for each multitrack session track.

   a. Click the “Stereo Mix” track in the multitrack session so that it is highlighted, right-click “1:Mono” from the POD dropdown in the ‘Files’ window: Insert into Multitrack > [Name of the Session]

   b. Add “3:Mono” to “Mic 1”.

   c. Add “4:Mono” to “Mic 2”.

   d. Add “5:Mono” to “Mic 3”.

   e. Add “6:Mono” to “Mic 4”.

   f. Add “7:Mono” to “USB”.

   g. Add “9:Mono” to “TRRS”.

   h. Add “11:Mono” to “Bluetooth”.

   i. Add “13:Mono” to “Sound Pads”.

7. From here you can just follow the “Exporting Files from Audition” section below.
Exporting Files from Audition

*Note: If you are using Audition as your primary DAW (Digital Audio Workstation) for mixing, you will do this after you finish your episode cut. In that multitrack session, just select Stereo in the Mix Dropdown to get your episode’s master track.

1. File > Export > Multitrack Mixdown > Entire Session
   a. In the window that pops up, name your file, pick a file location, and choose Wave PCM as the Format.
   b. The Sample Type is “Same as Source”, Format Settings are Wave Uncompressed and 32-bit Floating Point.
   c. For Mixdown Options click ‘Change…’
   d. Under the Mix dropdown, nothing should be selected.
   e. Click the box next to Tracks to select everything in the Tracks dropdown menu. This will export the master track from the RODECaster, as well as each individual microphone stem. You may want to only select Stereo Mix, Mic 1, Mic 2, Mic 3, and Mic 4 to save space (assuming you used all four mics).
Audio Restoration

There is a principle in audio restoration that states that you want to remove the most significant sources of audio impurities first. Work from the biggest, most glaring issues first, slowly working down to minute details. However, you do not want to just slap on your audio repair plug-in and crank all the settings to max. This will warp and distort your audio with artifacts, to the point of incomprehensibility. What I generally do is throw the clip I want to restore into my favorite DAW and make a copy so that I can always reference what I am editing to the original. In your audio restoration plug-in, I use Izotope RX 10 Elements, crank the setting until you hear the issue go away, then slowly back it off until you start to hear it again. From that point, increase it just a little bit slowly until it goes away again, and that should be the sweet spot for that setting.

1. Clipping
   a. The first and most significant issue that needs to be fixed is clipping. Clipping occurs when the signal being recorded is too loud which causes the loudest portions of the audio to be cut off, or clipped. Clipping is an issue that is easy to be seen by looking at the waveform of the audio and is when the peaks of the waveform are flat. It sounds distorted, glitchy, or if your speakers are starting to die. The best way to fix clipping is to prevent it! The recording portion of this guide will help with that. If you cannot rerecord, your best bet is to use a De-Clip plug-in.

2. Clicks
   a. Next are clicks. Clicks are small, short transients like crackles, pops, and lip smacks and snaps. If you are working with voice, there will be clicks in your audio. Play with the De-Click plug-in settings until you are satisfied with how your audio sounds. As always, do not crank the settings too high or you will cause artifacts. Sensitivity will increase the number of clicks.
detected as it is increased. Click widening increases the length of time that the signal is attenuated after a click is detected.

3. Hum
   a. Not a super common issue but one that is challenging to remove. Hum is a steady tone that may also sound at the harmonics of the fundamental frequency of the hum. The De-Hum plug-in in RX Elements has a feature where it can listen to the audio and detect if there is a hum. Sensitivity will increase the amount of hum attenuated. Bands determine the number of notch filters used to attenuate hum. Filter Q is how wide the attenuation bands are, the larger the number, the more narrow the band.

4. Noise
   a. Noise is super common and depending on the kind of noise can be really easy or challenging to remove. Noise in this case is a steady sound that has little or no variation in volume over the course of the clip we are restoring. Since we are just working with voice, we will be using the Voice De-Noise plug-in. If there is significant background noise, I will run Voice De-Noise first then take a pass with overall noise reduction in RX Repair Assistant. The interface is really intuitive and it will do a lot of the work for you.

5. Variable Noise
   a. The last category of audio impurities we like to remove is variable noise. Variable noise encompasses things like plosives, sibilance, and unwanted reverb. These can be taken care of with the RX Repair Assistant. Sibilance is the harsh hissing sound that is produced on s and t sounds. While there is a sibilance setting, it may sometimes be too much for just the one plug-in to handle and so sibilance can also be mitigated with EQ. Plosives are the popping low-frequency transients that are produced with p and b sounds. RX Repair Assistant has a slider for De-Essing and De-Reverb, but what about managing plosives? For that, we have to use EQ.
EQ

EQ is an extremely powerful tool in a producer’s toolbox. EQ, or equalization, is a tool that allows you to control how much you hear at a certain frequency. EQ may be the easiest aspect of mixing to learn at a fundamental level, but the hardest to master. The human ear can hear frequencies in the range of 20–20,000 Hz. Within this range are smaller ranges, that the audio engineering community has given names to.

On the x-axis of this graph is the frequency, and on the y-axis is the amount present. For example, too much in the range of 20-100 Hz is boomy, while too little is thin or anemic. One would want to be in the Goldilocks range of power or thickness.

Getting better with EQ involves practice and ear training. To master EQ is to understand what frequencies make an audio clip sound the way it does, and then increase or decrease these frequencies to mold the sound into what you want. I typically use what is known as subtractive EQ, which is where you remove problem frequencies. Here is what I like to do as a starting point for all my dialogue tracks:
1. Put a high-pass filter at about 150-250 Hz to help mitigate plosives.

2. Use a 3 dB cut at around 1000 Hz to help reduce the nasally sounds in a voice.

3. Use a 3 dB cut around 5000-7000 Hz to help reduce sibilance.
This is all subjective and varies from listener to listener and engineer to engineer. It is also very situational, different mics have different frequency responses and will record sound differently. It is all about using your ear to shape the sound how you think would sound best.

**Normalization**

Normalization is a process in which you raise the gain on a clip until the peaks max at -3 dB. It helps to set a baseline volume for the clip so that it is easy to work with as you begin to assemble the episode cut and use effects. Adobe Audition has a great integrated normalization function.

**Quote Retrieval**

After doing audio restoration on the whole interview file, I like to then export the whole restored file to do quote retrieval with. This will save all the audio restoration effects with the restored file and help save some RAM while you assemble the episode cut. With the clips exported and audio restored, you can now throw them into Descript. Descript is an audio transcription service that allows you to search for the clips specified in the script. Using Descript for quote retrieval is pretty simple.

1. After opening Descript and logging in, click New Project in the top right.
2. Select “Choose a file to transcribe”.
3. Select the one of the files you just exported and want to find clips from.
4. Ctrl+F (Cmd+F on Mac) to search for the clip specified on the script.
5. You can export this clip straight from Descript by highlighting the text and clicking Publish in the top right.
   a. Publish > Export. Settings should be Audio, Current Selection. In the quality dropdown, format is WAV, channels 1, 48000 sample rate, and normalize volume off.
6. I just name these clips “Clip 1, Clip 2, …” in the order they appear on the script.

**Assembling the Cut**

Simply follow the script. You can reference previous episodes to maintain continuity for things like intro and outro length.

**Compression**

Compression is a wonderful tool that is going to be your best friend when it comes to maintaining consistent levels. Compression attenuates signals above a certain amplitude that you set and will help to smooth out the volume of the track you are working with. Too much compression and your track will sound boxy with none of the dynamic range of the speaker's natural voice. Good compression will add some warmth and color to the audio while helping to control the dynamics of the track. Every compressor sounds different and will add something different to the track. I use the compressor in Izotope's Neutron Elements 3 plug-in. There are a few settings most compressors will have that you should know:

1. **Threshold**: This is the level above which the signal will be attenuated. A high threshold means compression will not be active on the majority of the signal. A low threshold means the opposite.

2. **Ratio**: This is how much signals above the threshold will be attenuated. A 1:1 ratio means no signal attenuation, while a higher ratio like 10:1 will attenuate the signal a lot.

3. **Attack**: This is how quickly the compressor kicks in after it ‘hears’ a signal that goes above the threshold. 1 ms attack means that the compressor will reach max compression set by your ratio 1 ms after a signal goes above the threshold.

4. **Release**: This is how long the compression stays active before returning to inactivity. 300 ms release means that it will take 300 ms for the compressor to return to no compression after it hits the max compression.

5. **Knee**: The knee of a compressor controls the transition between no compression and max compression. A hard-knee or no knee means that the compressor is
essentially either on or off. A soft-knee will smooth the transition out so that the compression will grow gradually from off to on and vice versa.

6. **Make-up Gain**: Make-up gain is the amount a signal is boosted after compression is applied.

For compression on dialogue, a ratio of 3:1 or 3.5:1, with a slower attack and release around 25 ms and 100 ms respectively. You may be able to get away with a higher ratio with a softer knee. Use make-up gain appropriately to maintain a constant volume between all speakers.

**Gain Staging and Automation**

Now it is time to gain stage within your DAW. I do this by lowering all the volume sliders to their minimum and then going track by track and increasing them to an appropriate volume. For podcasts, vocals should be at the forefront and any songs or
sound effects should be in the background. I find it really helpful to visualize your speakers in front of a live band and use that mental image to imagine what that would sound like. When you are done with this, the master track should be peaking between -4 dB and -6 dB at its absolute maximum. Since amplitudes are added when they sound simultaneously, I am looking for each track to peak between -6 dB and -8 dB at their loudest.

Once you have baselines set, you can use automation to fade clips in and out so that the entrance of a new clip or sound is not jarring to the listener. This is done in Audition by selecting Show Envelopes and Volume. Once you have your envelopes displayed, you can either draw your automation curves or record them. To add track automation:

1. Hit the arrow to the left of where it says “Read” and ensure what you want to automate is displayed next to “Select”.
2. Click the yellow line to insert keyframes.
3. Utilize the keyframes to create the shape you want for your volume curve.
   a. If you right-click the yellow automation line, options will pop up that give you greater control over the shape of your automation such as adding spline curves.

**Panning**

Panning refers to the practice of manipulating how much of the final signal of a track appears in the left and right channels of the master track. If a track is panned hard left, it will only go through the left channel of the master track and sound like the source of the audio is coming from the listener’s left. Panning can help make room in the mix for different voices and sound sources. Once again, visualization is a great tool.
I imagine sitting around a table with the hosts interviewing the guests. Based on those positions in my head, I will pan the audio accordingly. It is not generally a good idea to hard pan any track all the way left or all the way right because you could completely lose that track if the listener is listening in mono. Panning mono tracks in a vacuum could sound unnatural to the ear, so I use light reverb to give more of a sense of space.

Here is where you control panning in Audition.

**Reverb**

Reverb is the accumulation of reflections caused by natural bouncing of sound waves off different surfaces. Too little reverb and the space the episode was recorded in will sound dry and lifeless. Too much reverb and the space will sound like it was recorded in a parking garage. I like to use light plate reverb to help mitigate the unnatural quality of panning mono sound, and to add a little warmth and character. This will help make it sound like the listener is in the room with the hosts and guests as a fly on the wall.

**Final Mixing Notes**

A tip I highly recommend for a signal processing, especially compression and reverb, is to utilize the wet/dry composition of the plug-in in question. For example, if you like the characteristics a certain reverb adds to the sound, but it still feels like too much, you can edit the wet/dry composition to something like 70/30 or 40/60. Wet refers to the processed signal, while dry refers to the unprocessed signal. A mix of 70/30 wet/dry means that what you hear is 70% processed and 30% unprocessed.

If you are satisfied with everything and it sounds like your reference tracks, you can export that first master cut! It is now vitally important that you take a day or two off to rest your ears. It can be an exhausting process to listen critically for hours at a time in an attempt to create the perfect mix. In addition, it will be completely impossible to have an impartial ear after being exposed to the same sounds for hours.
upon hours. Fortunately, the hardest part is done for now! Send your first cuts out to your team so that they can help you review them and you can make any edits prior to mastering. I just want to reiterate that there are many paths to a good mix and it can be subjective. However, a good mix will be balanced and all parts will contribute to the episode cut.

**Mastering**

Mastering is the glue that will hold everything together. A good master will elevate the quality of the mix and prepare it for distribution. This portion, while still subjective, I would argue is much less subjective with mixing. There are a few concrete goals you want to achieve with a master.

1. If you missed it at the end of the mixing section, the first step to a good master is to **TAKE A BREAK**! Give your ears time to rest and recoup.
2. Make a new session and import your reference audio tracks along with your mix.
3. Solo your mix and take a good analytical listen for mistakes, things you don’t like, or anything else you want to change.
4. Use a mastering compressor, like the one in Izotope’s Ozone 9 Elements, to lightly compress the cut. You’re aiming for 1-2 dB of gain reduction.
5. EQ the cut to match the tone qualities of your reference tracks.
6. Use a limiter to increase the loudness of your mix. You want 2-4 dB of gain reduction at the loudest points.
7. Use a meter to determine the loudness of the mix. Make sure it is an appropriate loudness and dynamic range. A unit called a loudness unit full scale (LUFS) is the standard method of determining this. Aim for -14 LUFS.
8. Export your final, mastered cut! Once it’s approved you’re done!
References


iZotope. “Ultimate Guide to Podcast Production.” iZotope,


https://rode.com/en-us/user-guides/rodecaster-pro


https://helpx.adobe.com/audition/user-guide.html